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CHAPTER 1. INTRODUCTION

1.1 BACKGROUND

The first mechanistic model of continuously reinforced concrete pavement (CRCP),
CRCP-1, was developed in the mid-1970s under a project sponsored by the National
Cooperative Highway Research Program (NCHRP) (Ref 1). In 1991, Won et al. developed
an improvement to the CRCP program, CRCP-5, that simulates material variance to concrete
tensile strength and includes fatigue failure models (Ref 2). The normalized curing curves
were determined for different coarse aggregates commonly used in Texas pavements (Ref 3)
and these curves and the calibrated failure prediction model were included in CRCP-7 (Ref
4). In 1995, previous versions of the CRCP programs were integrated into one program,
CRCP-8, with simplification of the user input process (Ref 5). However, there were still
some limitations in CRCP-8 owing to the simplified assumptions of the one-dimensional
analysis. In 1996, a preliminary investigation was conducted to expand the ability of the
mechanistic model by incorporating the variations in temperature and moisture changes
occurring through the depth of concrete slab; the result of this investigation was a two-
dimensional finite element model (Refs 6, 7). In 1998, the Texas Department of
Transportation (TxDOT) extended the project to complete the development of a new
mechanistic model, CRCP-9. The analysis engine of CRCP-9 could be developed using two-
dimensional finite element theories to create a mechanistic model of the CRC pavement
systems, the crack spacing prediction model was developed using the Monte Carlo method,
and the failure prediction model was developed using probability theories (Refs 8, 9). While
the previous computer program, CRCP-8, used one-dimensional analytical methods to
calculate stresses and strains, CRCP-9 uses totally different two-dimensional numerical
methods to perform calculate them. Some of the major characteristics of CRCP-9 that differ
from those of CRCP-8 include consideration of nonlinear variations in temperature and
drying shrinkage through the depth of the concrete slab, nonlinear bond-slip relationship
between concrete and steel bars, viscoelastic effect of concrete, curling and warping effects,
and the ability of changing locations of the longitudinal steel bars.

1.2 INSTALLATION OF PROGRAM AND COMMUNICATION BETWEEN FILES

The CRCP-9 computer program contains five files of crcp-9.exe, fort.exe, crcpfor.inp,
crepfor.out, and crepfor.sum. Crcp-9.exe is an application program to generate a Windows-
based user-friendly interface developed by using Visual Basic; fort.exe is another application
program to perform the analysis developed in Fortran language; crcpfor.inp is an input file;



crepfor.out is an output file; and crcpfor.sum is an analysis summary file. To install the
CRCP-9 program, create a new directory, such as CRCP-9, on the hard disk drive and copy
all files in the directory. Any other setup is not needed. To start using CRCP-9, double click
on CRCP-9.exe; the CRCP-9 main screen will then appear. The CRCP-9 program can also
run on the floppy disk drive, but it is highly recommended that users use it on the hard disk
drive to reduce run time. CRCP-9 cannot run on a CD, even if CRCP-9 files are saved on it.
CRCP-9 can run on any PC or compatible with Windows 95 or later versions.

Communication between various files is explained. When users click on the Analysis
button in the last general input screen of CRCP-9 (details of input screens are explained in
Chapter 2), the input file of crcpfor.inp is generated and fort.exe starts running. Fort.exe calls
crepfor.inp and performs the analysis. At the end of the analysis, fort.exe generates the
output file of crcpfor.out and the summary file of crcpfor.sum. Crcp-9.exe periodically
checks the progress of the analysis; if the analysis is completed, crcp-9.exe calls the output
file of crcpfor.out to show the results on Windows-based interfaces. The summary file of
crepfor.sum is used when crcp-9.exe calls it because users would like to see the summary of
the analysis in document form. It should be noted that the necessary files of CRCP-9 are
crep-9.exe and fort.exe. However, the other three files are also needed for CRCP-9 to operate
all its functions just after installation. If there are no such files as crcpfor.inp, crcepfor.out,
and crcpfor.sum when installed, these files will be generated automatically after users
perform any analysis.

1.3 ORGANIZATION

This report consists of four chapters. The background, installation procedure of the
computer program, and communication between files are explained in Chapter 1. The user
input process with detailed explanations of each input screen is presented in Chapter 2. In
Chapter 3, details of the output screens are explained. Chapter 4 describes the file control
and print processes. References are listed at the end of the report.



CHAPTER 2. INPUT GUIDE

2.1 INTRODUCTION

Figure 2.1 shows the main screen of CRCP-9. There are four menus: File, Analysis,
Print, and Help. To begin a user input process, click on the Analysis menu. Displayed under
this menu, as shown in Figure 2.2, are four items: General Input, Advanced Input, Latest
Output, and Review Analysis Summary. The menu items of General Input and Advanced
Input are related to the input process. The General Input item is used to define geometry,
concrete and steel material properties, bond-slip relationships between concrete and steel and
between concrete slab and base layer, wheel loads, and such environmental loads as changes
in temperature and drying shrinkage. The Advanced Input item is used to define creep,
curling and swelling effects, number of primary crack spacings, finite element type, and
reliability. Users can select either Advanced Input or General Input to begin a user input
process. On any general input screen, users can go to the Advanced Inputs screen by clicking
on the Advanced Inputs button. Users can also go to the first general input screen of
Concrete Properties from the Advanced Inputs screen by clicking on the General Inputs
button. In this guide, it is assumed that General Input is selected first, then a new screen to
define concrete material properties will appear.

=100 x|

File  Analpsiz Print Help

CRCP -9

Analysis of Continuously Reinforced
Concrete Pavements

o |
'_._{.l.' nter for TMI'ISIIITI-IE‘HI“.I'I Research

Unkeersity of TENAS at Rustin

A 7exas Department of Transportation

Figure 2.1. Main screen of CRCP-9
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Figure 2.2. Menu items under Analysis menu

2.2 GENERAL INPUTS

2.2.1 Concrete Properties

The concrete material properties are defined in the Concrete Properties screen shown
in Figure 2.3. Any descriptive information can be entered in the first line to identify the
problem. Pavement thickness (thickness of concrete slab), Poisson’s ratio, specific weight,
and coefficient of variation for concrete tensile strength are defined in the upper portion of
the screen. Thermal coefficient, elastic modulus, tensile strength, compressive strength, and
drying shrinkage are defined next. If the coarse aggregate used is identical or similar to one
of the eight different types listed, select the appropriate aggregate type as shown in Figure
2.4. Once an aggregate type is selected, the material properties automatically change to their
default values. If the default values have to be changed or if there is no appropriate aggregate
type, users can insert their own values by selecting Modify Values, as shown in Figure 2.5. If
you click on Modify Values, the input fields are enabled for users to modify them. Because
the earlier curing time data are automatically calculated in the program using normalized



curves obtained from a previous project (Ref 3), the time histories of material properties
depend on the aggregate types. Even if there is no appropriate aggregate type in the list, it is
needed to select the most similar aggregate type and to change the default values. For
instance, when you choose Limestone from the list and change the elastic modulus to
4,000,000 psi at 28 days, and when you choose SRG and change the elastic modulus to the
same 4,000,000 psi at 28 days, the elastic moduli for the earlier days will be different, even
though you put the same elastic modulus at 28 days, because the normalized curves for
limestone and SRG are different.

Once the input process for concrete material properties is completed, click on the
Next button to go to the next screen. If you click on the Cancel button at anytime, the input
screen disappears. If you select the General Input item under the Analysis menu again, the
Concrete Properties screen comes out again with the default values. If you need to save all
the input values, do not click on the Cancel button until the analysis is performed. Once the
analysis is completed, you can save your input values under the File menu on the main
screen. Details of the file controls are explained in Chapter 4.

= Concrete Propertties [ CRCP-9 ) il

Analysiz Description I

Pavement Thickness [ in ] 12
Poiszon’s Ratio of Concrete 015
Specific Weight of Concrete [ pcf | Ir
Coefficient of Yariation for Concrete Tensile Strength [ % ) Im—
— ILimestone j IUse Default Y alues j ]
Thermal Coefficient [ microstrain/F ) E.29
Elastic Modulus at 28 days [ psi ) IM
Tensile Strength at 28 days [ psi ] IF
Compreszive Strength at 28 days [ psi ) W
Diving Shrinkage at 256 days lm

Advanced nputs | Cancel | Next

Figure 2.3. Concrete properties screen
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15

Coarse Aggregate Type |_ Use Default Values |

Concrete Properties [ CRCP-3 )

Coarse Aggregate Type |— Use Default Values | =
Lz Default Walues

oo

—

Figure 2.5. Modification of default values for coarse aggregate type



2.2.2 Steel Properties

The material properties of steel and the arrangement of longitudinal steel bars are
defined on the screen shown in Figure 2.6. Elastic modulus, steel bar diameter, thermal
coefficient, specific weight, and percent reinforcement are defined first. The thickness of the
finite element is defined in the program by

7(Steel bar diameter)” | 4

(Concrete slab thickness)(Percent reinforcement)

Finite element thickness = x100 (2.1)

The longitudinal steel bar location from the surface of the concrete slab is defined
next by selecting a value from the list. In CRCP-9, because the number of finite elements in
the vertical direction is ten, the steel bar can be located at the same level as any finite element
node on the concrete slab. For instance, if the thickness of the concrete slab is 12 inches,
there will appear nine different values of 1.2, 2.4, 3.6, 4.8, 6.0, 7.2, 8.4, 9.6, and 10.8 in the
list. The default value is always selected to be of the mid-depth because most CRC
pavements have longitudinal steel bars at the mid-depth of the concrete slab.

g Steel Properties [ CRCP-9) |

Elastic Modulus of Steel Bar [ psi ] 29000000

Steel Bar Diameter [in ] IF
Thermal Coefficient of Steel [ microstrain/F ] |5—
Specific Weight of Steel [ pcf ) W
Percent Reinforcement [Steel Ratio) [ & ) IDE—
Steel Location from Surface [ in ] m

Advancedlnputsl Previous | Cancel | Next

Figure 2.6. Steel properties screen



2.2.3 Bond-Slip Relationship

The bond-slip relationships between concrete and steel bar and between concrete slab
and base layer are defined in the Bond-Slip Relationship screen shown in Figure 2.7. The
concrete and steel bond-slip is defined first by selecting a bond-slip relationship from the list.
There are four different bond-slip relationship models: linear, linear with ultimate slip,
bilinear, and bilinear with ultimate slip; each bond-slip model has three different stiffness
values: strong, moderate, and weak (see Figure 2.8). Once a relationship is selected, default
values are shown. If User Defined is selected, input fields are enabled for users to write their
own values.

There is frictional bond-slip at the interface between the bottom of the concrete slab
and the base layer (or subbase for typical rigid pavements). The vertical stiffness of subgrade
(or stiffness of subgrade reaction) and the bond-slip between concrete slab and base are
defined at the lower part of the screen. If a subbase type is selected from the list, a default
value of the bond-slip stiffness between concrete slab and selected subbase type is shown, as
in Figure 2.9. Users can insert their own values by selecting User Defined from the list.

oz Bond-5lip Relationship [ CRCP-9 ) ; 5'

— Bond Between Concrete and Steel Reinforcement —_

Type of Bond-Slip

tModerate Linear

Bond-Slip Stiffness # Unit Area [ psifin ] |52DDDD
Secondary B-5 Shffness / Umit Area [ psifin ]
Yield Slip [ in ]

Ultimate Ship [ in ]

— Bond Between Concrete and Base Layers —

Vertical Stiffness of Subgrade [ psifin ] 400
Subbase Type I,:|E,,:i|:,|.3 j
Bond-5hp Stiffness / Unit Area [ psifin ) |145_5

Advanced Inputs | Previous | Cancel | Next |

Figure 2.7. Bond-slip relationship screen



Bond-5lip Relationship [ CRCP-9]

— Bond Between Concrete and Steel Reinforcement —

Type of Bond-Slip Moderate Linear j
) ) ‘wheak Linear with Ultimate Slip
Bond-Slip Stffness # Un Siong Bilinear
Secondary B-5 Stiffnesg &%i?g;ﬁnaé!:ea[

- e Strang Bilingar with Ultimate Slip
W S ] Moderate Bilinear with Ulimate Shp
w'eak Bilinear with Lltimate Slio

Ultimate Slip [ in )

— Bond Between Concrete and Base Layers —

Vertical Stiffness of Subgrade [ psifin ) IdDD
Subbase Type IFIexibIe j
Bond-5lip 5tiffness / Unit Area [ psifin ] |145.5

Advancedlnputsl Previous | Cancel | Next

Figure 2.8. Selection of bond-slip relationship

Bond-5hip Relationship [ CRCP-9 )
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Type of Bond-5lip IModerate Linear j

Bond-5hp Stiffness / Unit Area [ psifin ) IW
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Unireated Cla,

Advanced Inputs |

Figure 2.9. Selection of subbase type




2.2.4 Loads

Applied loads on the CRC pavement system include external wheel loads and such
environmental loads as changes in temperature and drying shrinkage. These loads are
defined in the Loads screen shown in Figure 2.10. Wheel load, wheel base radius, and the
first day of wheel load application after the placement of concrete are defined first. Curing
temperature, days before minimum temperature, and types of temperature and drying
shrinkage through the depth of the concrete slab are defined next. Users can select one of
three types of temperature and drying shrinkage variations through the depth of the concrete
slab, which are uniform, linear, and nonlinear variations, as shown in Figure 2.11.

% Jpads [CRCP-9) x|

Ezxternal Load

Wheel Load [ Ibs ) ISDDD
Wheel Base Badius [in ] IB
Days After Concrete Sets Before Wheel Load Applied |14

— Environmental Load —_

Curing Temperature [ F ] 110
Days Before Minimum Temperature |120

Type of Temperature Variation through Depth ILineal vI
Type of Diying Shrinkage Yariation through Depth IUniform vI

Advanced Inputs | Previous | Cancel | Next |

Figure 2.10. Load definition screen



%t |pads [CRCP-9) x|

— External Load —

Wheel Load [ Ibs ) ISDDD
Wheel Base Radius [ in ) IB

Days After Concrete Sets Before Wheel Load Applied |14

— Environmental Load —

Curing Temperature [ F ] 110

Days Before Minimum Temperature

120
Type of Temperature ¥anation through Depth Linear vl

Type of Diying Shnnkage Yanation through Depth

ELinear

Monlinear

Advancedlnputsl Previous | Cancel | Next |

Figure 2.11. Selection of temperature variation type

2.2.5 Temperature and Drying Shrinkage

The temperature and drying shrinkage variations through the depth of the concrete
slab are defined in the Temperature and Drying Shrinkage screen. In the previous screen, if
users select the linear variation of temperature, the screen shows input fields at the surface
and bottom of the concrete slab as shown in Figure 2.12. T1 and T2 are daily minimum and
maximum temperatures. If users put temperatures at the surface and bottom, the program
generates other temperatures at finite element nodes using linear interpolation because the
variation has been selected to be linear. The days that correspond to input temperatures can
also be changed by inserting any day on which users have temperature data. However, the
temperature data on the first day after placement of concrete and on the day when the
minimum yearly temperature is reported should be entered (once entered, these fields may not
be changed). The temperatures between the input days will be linearly interpolated. For
instance, in Figure 2.12 the minimum surface temperature on Day 3 is 85 degrees and on Day
7 it is 80 degrees. Therefore, the minimum surface temperatures on Days 4, 5, and 6 are
defined to be 83.75, 82.5, 81.25 degrees, respectively. If users select the uniform temperature
variation in the previous screen, the screen shows input fields at the surface only, as shown in

11



Figure 2.13, because the temperatures will be the same through the depth. On the other hand,
if the nonlinear temperature variation is selected in the previous screen, users must put
temperatures at each finite element node as shown in Figure 2.14.

The drying shrinkage variation is similarly defined with the temperature variation.
However, users must understand what the drying shrinkage ratio means on the screen. The
drying shrinkage strain is defined in the concrete properties screen as shown in Figure 2.3.
This strain is not the same for the entire depth of the concrete slab. To account for this
variation in drying shrinkage strain, the drying shrinkage ratio is used. For instance, if the
linear variation is selected in the previous screen, users can define the strain through the
depth by putting drying shrinkage ratio values that range from 0 to 1 at the surface and
bottom of the concrete slab. If the drying shrinkage strain is 0.00005 on a given day and if
the drying shrinkage ratios at the surface and bottom are 1 and 0, respectively, the actual
drying shrinkage will be 0.00005 at the surface, 0.000025 at the middle, and 0 at the bottom.
Figures 2.12, 2.13, and 2.14 show a uniform drying shrinkage ratio of 0.5, which means
drying shrinkage strains are assumed to be uniformly distributed through the depth, and show
half of their values obtained from the curing curves.

e Temperature and Diying Shrinkage [ CRCP-9 ] x|

Depth Day 1 Da}llp Da}llg Dayl;-' Dap120
lin) 74722z M122 MT22 M122 MT122
Surface; 0.0 [1p0f110fo5 (30 [110fo5 |85 [10sfo5  [a0 [1o0jo5  f32 |2 Jos

— 1.2
— 2.4
— 36
— 4.8
Middle— 6.0
— 7.2
— &4
— 96
— 10.8

Bottom— 12.0 [110{100 {100{100 EES jan [a0 |52 |52
T1. T2 : Daily Minimum and Maximum Temperatures [F ], Z : Diying Shrinkage Ratio

Advanced Inputs | Previous | Cancel |  Analysis |

Figure 2.12. Linear temperature variation input screen
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2.3 ADVANCED INPUTS

2.3.1 Primary Crack Spacing

The Advanced Inputs screen is shown in Figure 2.15. In this screen, users can define
the number of different primary crack spacings, finite element type, creep effect, curling
effect, swelling condition, and reliability. The number of different primary crack spacings
can be one of the three listed values of 2, 4, and 8, as shown in Figure 2.16. The primary
crack spacing is the crack spacing with which the analysis begins. In CRCP-9, the first
primary crack spacing is assumed to be 50 ft and other primary crack spacings are defined by

2
Primary crack spacing (i) = 50 — (i — 1) ) (2.2)
Total number of primary crack spacings

where the unit of the crack spacings is in feet. For instance, if the number of primary crack
spacings is 4, the primary crack spacings are 50, 43.75, 37.5, and 31.25 ft. It should be noted
that selecting a large number of primary crack spacings increases reliability of the results, but
computational time also increases. From the preliminary study, the number of different
primary crack spacings slightly affects the results if that number is equal to or larger than 2.

t2  Advanced Inputs [ CRCP-9 ) x|
Mumber of Different Primary Crack Spacings |2 vI
— Finite Element Type
{* Plane Stress " Plane Strain
— Congideration of Yiscoelasticity [ Creep and Relaxation )
&y Max. Creep Ratio to Ingtantaneous Strain 2
&8 Percent Ratio to Max, Creep [ %] 99
N Comesponding Day to Above Ratio [ Day | a0
o Druration of Temperature Drop [ Hr ] 12

— Use of Tensionless Springs to Consider Curling and Warping Effects

* Yes " No

— Punchout Prediction Parameters

Reliability [ % ]

Swelling Conditions
’7 " Yes & No 50

L

Cancel | 0K |

Figure 2.15. Advanced inputs screen
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fc  Advanced Inputs [ CRCP-9) |

Humber of Different Primary Crack Spacings

— Finite Element Type
i+ Plane Stress i Plane Strain

— Consideration of Yiscoelasticity [ Creep and Relaxation )

@ Max. Creep Ratio to Instantaneous Strain 2

Qe Percent Ratio to Max. Creep [ %) 99

~ Cormresponding Day to Abowve Ratio [ Day | a0
b Dwration of Temperature Drop [ Hr ) 12

— Use of Tensionless Sprngs to Consider Curling and Warping Effects

* Yes " Ho

— Punchout Prediction Parameters

Reliability [ % ]
" Yes ' No 50

4

" Swelling Conditions

General Inputs | Cancel I 0K |

Figure 2.16. Selection of the number of primary crack spacings

2.3.2 Finite Element Type

Next, the type of finite element used for discretization of the concrete slab can be
switched between plane stress and plane strain elements. It should be noted that the concrete
stresses are slightly overestimated if the plane strain elements are used, and slightly
underestimated if the plane stress elements are used, as compared with the 3-D analysis
results (Refs 10, 11).

2.3.3 Creep and Curling Effects

Concrete viscoelasticity (creep of strain and relaxation of stress) can be defined next.
If the creep effect is not needed, select the No option in the concrete viscoelasticity; then
input fields will disappear from the screen as shown in Figure 2.17. The maximum creep
ratio to instantaneous strain, percent ratio to maximum creep and corresponding day, and
duration of temperature drop need to be filled when the creep effect is considered. Detailed
explanations of creep effect considerations can be found in the previous reports (Refs 6, 9).

The curling and warping effects are defined next. If any side of the concrete slab
curls, there can be a gap between the slab and the base layer. The tensionless vertical springs
that can sustain only the compressive forces have been developed to properly model this
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curling effect. It is noted that the curling effect in the CRC pavement is significant when the
transverse crack spacing is long and the temperature variation between the top and bottom of
the concrete slab is large (Ref 10). If the curling and warping effects are desired, select the
Yes option.

fc  Advanced Inputs [ CRCP-9) |

Humber of Different Primary Crack Spacings |2 vI
— Finite Element Type

(* Plane Stress " Plane Strain

— Consideration of Yiscoelasticity [ Creep and Relaxation ]

" Yes

— Use of Tensionlezs Sprngs to Consider Curling and Warping Effects

* Yes " No

— Punchout Prediction Parameters

" Swelling Conditions Reliability [ % ]

" Yes * No 50 v

General Inputs | Cancel | oK |

Figure 2.17. Selection of viscoelastic effect

2.3.4 Punchout Prediction Parameters

CRCP-9 predicts the number of punchouts per mile due to the wheel load
applications. The predicted number of punchouts depends primarily on the transverse crack
spacings, but swelling conditions and reliability also affect the punchout prediction equations
(Refs 4, 9). Users wanting to consider the swelling conditions should select the Yes option.
Users can also select one of the listed reliabilities (50, 75, and 95%), as shown in Figure 2.18.

When the input process has been completed, users may perform the analysis. To
conduct the analysis from the Advanced Inputs screen, first click on the General Inputs button
to go to the Concrete Properties screen, one of the General Inputs screens. Then click on the
Next button until the Temperature and Drying Shrinkage screen appears. Users can find the
Analysis button on that screen. Do not click on the Cancel button until the analysis is
performed. Once the analysis is completed, users can save input values to a file for future
use. The details of the file controls are explained in Chapter 4. If users click on the Cancel
button, the main screen appears and modifications of input values will be lost. If users click
on the Analysis button, the analysis begins and the progress will be shown as in Figure 2.19.
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Advanced Inputs [ CRCP-3 )

|

|

|

—

Figure 2.18. Selection of reliability

Perform Analysis [ CRCP-9 ]

NENEENEEERR

Figure 2.19. Perform analysis screen
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CHAPTER 3. OUTPUT GUIDE

3.1 INTRODUCTION

The analysis results from CRCP-9 include time histories of mean crack spacing, crack
width and steel stress at crack, crack spacing distribution, cumulative crack spacing
distribution, and the number of punchouts related to the wheel load applications. The input
values and analysis results are also summarized and can be shown in the crcpfor.sum file.
Once the analysis is completed, the information box shown in Figure 3.1 appears. If users
click on the OK button, the first output screen will appear. Users can also see the latest
output screens by selecting the Latest Output item under the Analysis menu from the main
screen. Also, the saved outputs can be shown from the File menu.

Analysis [ CRCP-9 x|

& Analysiz has been completed |

Figure 3.1. Completion of analysis dialogue box

3.2 CRACK SPACING

The first output screen shows the time history of mean crack spacing, as shown in
Figure 3.2. Users can easily see the variations in mean crack spacing with time from the
graph. Since the graph shows up to 12 ft of mean crack spacings, the mean crack spacings
greater than 12 ft will not be shown. The mean crack spacings and standard deviations on
each day until 28 days and on the last day of the analysis are listed in the table.

The crack spacing distribution on the last day of the analysis, which is typically the
day when the minimum yearly temperature is reported, can be obtained, as shown in Figure
3.3, by clicking on the Distribution button. In the table, the range of each crack spacing is 0.5
ft. For instance, a crack spacing of 2 ft represents the crack spacings between 1.75 and 2.25
ft. Cumulative values of the crack spacing distribution can also be obtained by clicking on
the Cumulative Distribution button, as shown in Figure 3.4. In the table, output values
represent the percentage of the crack spacings smaller than a certain crack spacing. For
instance, from Figure 3.4, we see that 44.74% of the crack spacings are smaller than 2.25 ft.
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°P2  Analysis Results [ CRCP-9)

Analysis Besults [ CRCP-9 ]

Figure 3.3. Crack spacing distribution screen
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g Analysiz Results [ CRCP-39) il
Crack Spacing |i C Steel Stress Failure
— Cumulative Crack Spacing Distribution on 180 Days after Plac
100 %
Time History |
78 %
Distribution | B0 %
25 %
Cumulative
Distribution 03 I
1] 5 ft [ 5 201
C5 | % C5 | % C5 | % C5 | % C5 | %
0.0 |o.0o 30 |3211 6.0 10000 | 9.0 [roooo (12.0 10000
0.5 |00 35 3474 6.5 10000 | 9.5 [oooo 1125 10000
1.0 |0.00 4.0 |9737 7.0 10000 | 10.0 10000 | 13.0 |100.00
1.5 1579 45 10000 | 5 [10000 | 105 10000 | 13.5 |100.00
2.0 |44.74 5.0 |10000 | 80 [100.00 | 11.0 10000 | 14.0 |100.00
25 |6B.42 55 10000 | 85 |100.00 | 11.5 |100.00 | 14.5 |100.00
C.5. : Crack Spacing [ ft )
Cloze |

Figure 3.4. Cumulative crack spacing distribution screen

3.3 CRACK WIDTH AND STEEL STRESS

The time history of mean crack width can be obtained by clicking on the Crack Width
button, as shown in Figure 3.5. The output format is similar to that of the time history of
mean crack spacing. The graph shows crack widths up to 0.04 in. The values of crack
widths are also listed in the table. The time history of mean steel stress at crack can also be
obtained by clicking on the Steel Stress button. Then, the screen shown in Figure 3.6
appears. This output format is the same as that of the time history of mean crack width.

3.4 PUNCHOUTS

The number of punchouts per mile according to the wheel load applications can be
obtained by clicking on the Failure button. The number of punchouts is shown for every 5
million ESALs and up to 100 million ESALs, as shown in Figure 3.7. The graph shows up to
twelve punchouts per mile.
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fP2  Analysis Results [ CRCP-9)

e

¢ Analysis Results [ CRCP-9)

Figure 3.6. Time history of mean steel stress screen
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e Analysis Results

[CRCP-3]

Crack Width

Steel Stress

Failure

12PM

— Predicted Punchouts / Mile [ P/M )

IP/M

B P/M

3IP/M

0P/M

Unit of ESAL = Millions

0 25 million 50 million 75 milion 100 million ESALS
ESAL| P/W ESAL| P/W ESAL| P/W E5AL | PAM
5 |0.00 30 |0.00 55 [1.18 80 (295
10 |0.00 35 |0.20 60 [1.36 85 (333
15 |0.00 40 |0.24 65 |[1.56 90 (423
20 |0.00 45 |0.54 0233 95 (473
25 |0.00 50 |0.75 5 |2E3 100 527

Close I

Figure 3.7. Punchout prediction screen

3.5 OTHER CHARACTERISTICS

The input values and output results for the analysis can be reviewed in document form
by selecting the Review Analysis Summary item under the Analysis menu.
shown in Figure 3.8 appears when the item is selected. This screen is generated from the
crcpfor.sum summary file and summarizes itemized input values and analysis results. Users
can copy content in the summary by clicking the right button on the mouse and by selecting
Copy from the pop-up menu after highlighting the content to be copied. The content can be
pasted into any other Windows-based program, such as Word and Excel, allowing users to

easily transfer the analysis data.
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*##xxxx NPT VALTES®#**%%

CONCRETE FROFERTIES

Pavenent Thickness (in.) = 12 0ooopoooooooo
Poigson Ratio of Concrete = 0.150000000000000
Specific Weight of Concrete (pof) = 145 000000000000

Coefficient of Variation for Concrete Tensile Strength (#)
10.0000000000000

Coarze Aggregate Type = Limestone

Thermal Coefficient (~F) = 6.289999873643044E-006

Ela=stic Hodulus at 28 days {(p=1i)} = 3604000

Tensile Strength at 28 days (p=i) = 434

Compressive Strength at 28 days (p=i) = 5000

Drying Shrinkage at 256 day=s = 0.000425

STEEL PROFPERTIES

_>|_I
FPrint | LCloze |

Figure 3.8. Analysis summary screen
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CHAPTER 4. FILE CONTROL AND PRINT

4.1 FILE CONTROL

Users can open, save, and delete input and output files by selecting an appropriate
item under the File menu as shown in Figure 4.1. To save an input or output file, first
perform the analysis and then click on the Close button in any Analysis Results screen to go
back to the main screen. Then select the Save Input File As option to open the dialogue box
shown in Figure 4.2. Select the directory where the input file is saved and write the name of
the input file in the File Name field. The name of the input file to be saved must have an
“inp” extension. The analysis results can also be saved similarly by selecting the Save
Output File As option under the File menu. The name of the output file must have an “out”
extension. Users can also open existing input and output files by selecting Open Existing
Input File and Open Existing Output File items, respectively, under the File menu. The
existing input and output files can be deleted by selecting Delete Existing Input File and
Delete Existing Output File items under the File menu. Other files, except CRCP-9 input and
output files, cannot be deleted by using those menu items to protect the files. To quit CRCP-
9, select the Exit item under the File menu or click on the cross mark at the upper-right
corner of the screen.

=lo1x|

File Analysiz  Print Help
Open Esisting Input File

Open Existing Output File

Save [nput File Az...
Save Output File As...

-
[relete Existing Input File

Delete Existing Output File

Exit

Analysis of Continuously Reinforced
Concrete Paverments

=y
'_._{.1:6"0' for Transportatien Research

The Unkersity of TEdas at Rustin

A 7exas Department of Transportation

Figure 4.1. Menu items under File menu
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St GSave Input File Az, x|

File Hame Directories

I |D: 5P avProgram' CRCP-3

l:rl:pfl:_nr.inp e
b7 ivp £ PavProgram

& CRCP-9

File Type Drive
Input Files [*inp) j I =4 j

Save Cancel

Figure 4.2. File control screen

4.2 PRINT

The analysis summary and all screens, such as the main, input, and output screens,
can be printed by selecting items under the Print menu, as shown in Figure 4.3. The analysis
summary, shown in Figure 3.8, can be printed by selecting the Analysis Summary item under
the Print menu. The input screens — advanced inputs, concrete properties, steel properties,
bond-slip relationship, loads, and temperature and drying shrinkage — can be printed by
selecting the appropriate item under the Input Screen menu item, as shown in Figure 4.4. The
output (analysis results) screens of time histories of mean crack spacing, crack width and
steel stress at crack, crack spacing distribution, cumulative crack spacing distribution, and
predicted punchouts per mile can also be printed similarly, as shown in Figure 4.5. If any
item under the Print menu is selected, the dialogue box shown in Figure 4.6 will appear to
ensure the users’ print intention. If users click on the Yes button in the Print dialogue box,
the selected screen or analysis summary will be printed. The print quality depends on the
printer. The information on CRCP-9 shown in Figure 4.7 can be found by selecting the
About CRCP-9 item under the Help menu in the main screen.
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=100 x|

File  Analysiz | Print Help
Analysiz Summary

Main Screen
Input Screen 3
Output Screen »

RCP-9

Analysis of Continuously Reinforced
Concrete Pavements

'J
Wr Transportation Research
The UnNErSITY of TENAS 8t RuUsTin

l Texas Department of Transportation

Figure 4.3. Menu items under Print menu

=100 x|

File  Analysiz | Print Help
Analysiz Summary

Main Screen

Input Screen Advanced Inputs

Output Screen » Concrete Properties
Steel Properties
Bond-Slip Relationship

Loads
Temperature and Diyving Shinkage

Analysis of Continuously Reinforced
Concrete Pavements

'J
Wr Transportatien Research

NNErSIY of TERAS T Austin

l Texas Department of Transportation

Figure 4.4. Menu items under Input Screen
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File  Analysiz | Print Help
Analysiz Summary

Main Screen

Irput Sereen Pl e o s—

Dutput Screen Time Histary of Mean Crack Spacing
- | Crack Spacing Distribution

Cumulative Crack Spacing Distribution
Time Histary of Crack 'wfidth
Time History of Steel Stress at Crack

Anau Fredicted Punchouts Per Mile fnforced
Concrete Pavements

J
W- Transporiatien Research
¥ The Unkersity of TExas at Austin

A 7exas Department of Transportation

=lo1x|

Figure 4.5. Menu items under Output Screen

@ D'a pow want ba print input [Concrete Properties] screen 7

=*  About CRCP-9

c CRCP-3 “ergion 1.0
Rc Faor analyziz of continuouzly reinforced concrete pavements

pn"’ Copyright 2000 University of Texaz at Austin and T=DOT

Developed by
Seong-Min Kim. Moon C. Won, and B. Frank McCullough

Figure 4.7. About CRCP-9 dialogue box
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